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Morningstar tRx Onboarding Guide

Welcome to Morningstar Total Rebalance Expert (tRx). This platform helps you Overview
streamline your business with efficient rebalancing and portfolio management. A
sample of tRx's core capabilities are described in the table below.

Feature Description

Analysis Expert Instantly analyze and view results, allowing you to identify which clients require action — at
a glance.

Rebalancing tRx calculates trades while considering your parameters, maximizing tax savings, minimizing

transaction costs, and avoiding redemption fees. Additionally, tRx allows you to compare and
choose trades with or without location optimization, based on costs vs. tax savings.

Cash Management tRx automatically considers cash requirements at the model, account, and client levels.

Tax Loss Harvesting With tRx, you can harvest tax losses opportunistically, creating ongoing tax savings and avoiding
the crunch at year end.

Savings Reports Quantify the tax savings you generate for your clients with client-friendly benefit reports.

This manual provides step-by-step instructions to set up the platform in preparation for
rebalancing. The following topics are covered:

» Preparing for Rebalancing in Morningstar tRx (page 5)
» Logging into Morningstar tRx (page /)

» Scheduling Automatic Uploads (page 10)

» Importing Data into tRx (page 12)

» Householding in Marningstar tRx (page 14)

» Creating Asset Class Categories (page 17)

» Assigning Securities in Asset Classes (page 20)

» Creating Models (page 25)

» Creating Buy Sets (page 29)

» Troubleshooting Data Errors after Import (page 32)
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Preparing for Rebalancing in Morningstar tRx

Overview

Preparing for Rebalancing in Morningstar tRx

Before you rebalance your clients portfolios, you must first complete a series of steps to
prepare the platform. Some of these steps only need to be completed once, while
others must be completed on an on-going basis. The table below describes each of

these initial steps:

This step

Set up automatic exports from
Morningstar Office to tRx

Requires this action

After a one-time set up, data will automatically be pulled from
Morningstar Office into Morningstar tRx. This export extracts the
following data:

» household (client) data,

» account data,

» models,

» positions,

» realized gain loss information,

» trade lots, and

» transaction data for all transactional accounts that are included in the
client aggregate within Morningstar Office.

@ Note: The export will not include any quick (positional) accounts or accounts
that are excluded from the client aggregate.

Import data into tRx

This step requires you to import your daily data extract from Morningstar
Office into Morningstar tRx. Importing daily ensures that you are using
the most recent data during rebalancing.

Create Households in tRx

This step requires you to combine all the accounts belonging to a single
client into one complete client record. By default, accounts are imported
using the same grouping as in Morningstar Office. This step is only
necessary if you want to change these groupings and rebalance using a
different strategy.

Create Asset Class Categories

Creating Asset Class Categories is a one-time step competed during your
initial import from Morningstar Office into tRx. This step is only necessary
if you choose to classify securities differently than how Morningstar
Office classifies securities. This step is commonly completed if you choose
to rebalance at the security level rather than the asset class level.

Assign Securities to Asset Classes

This step requires you to assign securities to each asset class. Securities
will come through assigned to asset classes during the initial import from
Morningstar Office, however, they may need to be reassigned to different
asset classes, depending on how asset classes are set up in tRx

Security classification determines the asset allocation for each account.
During the rebalancing process, accounts are compared to model
portfolios to determine whether the account is out of balance.

From there, tRx will determine what trades tRx will propose.

MAORNINGSTAR
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Preparing for Rebalancing in Morningstar tRx

Overview

This step

Create Model Portfolios

Requires this action

Model portfolios are also imported during the initial import from
Morningstar Office into tRx. Morningstar Office model portfolios are
comprised of securities.

However, you may wish to create new models within tRx to reflect the
asset class set up within tRx. If you rebalance using subclasses rather
than securities, you must create subclass level models within tRx.

Create Buy Sets

The buy set holds the preferred buys that will be purchased in the event
that a subclass is under weighted in the account when compared to the
model. The preferred buys have to be specified before the client will be

able to rebalance in tRx. The client can also create additional buy sets if
they want to have different preferred buys for different clients or groups
of clients.

MAORNINGSTAR
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Logging into Morningstar tRx Overview

Logging into Morningstar tRx

Locate your login credentials in the secure onboarding email sent to you from our Overview
service team. If you have not received your email or have trouble logging in, please
contact your Customer Success Manager.

In this section the following topics are covered:

» How to log in to Morningstar tRx,(page 7) and
» How to reset your password. (page 8).

To access Morningstar tRx, type trx.morningstar.com into your browser. Bookmark this How do | log into
page to easily return to it later. From here, log in using the Morningstar tRx credentials Morningstar tRx?
provided to you.

MAORNINGSTAR Total Rebalance Expert

models.demo
Enter your user name and

password here.
L1111 1]]

Forgot your password? Sign In

Morningstar tRx February 2019 7
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https://trx.morningstar.com/

Logging into Morningstar tRx How do | reset my password?

How do | reset my

To change your password in tRx, do the following:
password?

1. From the Log in screen, click Forgot your password?. A box opens.

MAORNINGSTAR Total Rebalance Expert

models.demao

our ord? 2 -
ST e | SignIn Click here to start.

2. Inthe User Name text field, type your user name.

Please anter your username below. An email with instructions
on how to resat your password will be zent to the email
address associated with your user account.

2944579

For assistance, please contact Support at (619) 2

IJSEI’ Name Enter your User Name here.

Morningstar tRx February 2019
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Logging into Morningstar tRx How do | reset my password?

3. Click Submit. A box alerting you to check your email opens.

Request submitted successtully

If the username matches an existing user account, you wi
receive an email at the email address associated with your

0K I Click here.

user account.

4. Click OK. Check your email account that is associated with your Morningstar tRx
account. Click on the link inside the email. The Manage Password box appear.

5. Inthe Text fields, enter your User Name and New Password. Then confirm your
new Password.

Manage Password

For assistance, please contact Support at (619) 294

User Name: ©

Enter your User Name and

New Password: * New Password here.

Confirm New Password: *

Password Complexity Requirements (items in red must be corrected):

Must not match previous password
Minimum 8

¢ Must not contain username

6. Click Reset Password.

Morningstar tRx February 2019 9
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Scheduling Automatic Uploads Overview

Scheduling Automatic Uploads

After your Client Success Manager syncs Morningstar Office with tRx, you can set up a Overview
schedule so that your exported positions by lot files are automatically uploaded to the

tRx platform daily or weekly, saving time by avoiding a manual upload process. This

section describes how to set up a schedule to automatically upload data.

< Note: schedule your export after you complete all necessary import and reconcilation tasks
within Morningstar Office.

To schedule automatic uploads of positional data, do the following: How do | schedule
automatic uploads of

1. Login to Morningstar Office using your Morningstar Office credentials: "
g 9 9y 9 positional data?

MAORNINGSTAR

classroom 1 @morningstar com

Enter your Morningstar
Office credentials here.

Forgot your password?

Morningstar tRx February 2019 10
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Scheduling Automatic Uploads How do | schedule automatic uploads of positional data?

2. From the toolbar at the top of the window, click Tools...Export...Account Positions by
Lots. The Export Account Positions by Lot dialog box opens.

’-.Ij-ﬁ Morningstar Office
File MNew Favorites | -Iou\s I Reports Help : & Import : [&]Price Monitor - [ QuoteSpeed @ Sed
Edit Definition Master
Home 5
Hypothetical Illustration -
Client Management Efficient Frontier search~ | &, Smart Search | tm
H Clients Suitability Manager 3 4 Birthdsy Date
E Prospects Settings ¥
g Contacts Find »
E B\II\.n.g. Market Barometer
E Activities
i Calculators 2
H Alerts o
= Mail Merges TiadeBlater
B Task Manager Batch Document Upload
E Nate Manager Launch Web Portal 12/15/1975
r B8 Workflow Launch Corporate Action Warshouse 12/15/1975
E Saved Reports Global Transaction Wizard (3
= Rebalancing Advisor-Client Questionnaire ¥
T 3 - You only need to set up your
Account Positions 8
automatic export once
[T 11 John Cena | Account Positions by Lot
| W Miles Family

3. From the Schedule Export area, check Create Export Schedule.
4. Select Frequency. Then select a Start time.
& Note: This export includes transactional accounts only. The start time should occur after daily
import and reconciliation.
5. From the Rebalance Tool drop down, select Total Rebalance Expert (TRX)
6. Enter the email address where you want to be notified that your export is complete.

[ Momingstar Office =i

Export Account Positions by Lot ( ing model p ios)

To generate a new export, click "Run Export Now". The five most recent exports are shown
below. The exported XML file can be used in the following rebalance tools: iRebal, Total
Rebalance Expert (TRX), TradeWarrior, ATOM ALIGN (BlazePortfolio) and RedBlack Rebalance
Express.

O Group each Account ID in its own Group
O Group Account ID for Clients

@ Group Account 1D for Groups

Run Export Now

Schedule Export

M Create Export Schedule
Frequency Daily >l

Start Time 11:00 AM vler

Select the Schedule Frequency
and Start time that works best
M Upload to rebalance tool when export is done ] Using Import Open Lot CB for you.

Rebalance Tool Total Rebalance Expert (TRX) s

Please enter email address to be notified when export is complete:

elizabeth.morgan@morningstar.com

Recent Exports

Aceounts Grouped by Date Start Time End Time File Type

Group 4/21/2017 11:10:00 AM 11:10:00 AM Automatic !

Group 4/20/2017 11:04:00 AM 11:04:00 AM Automatic !

Group 4/19/2017 4:38:00 PM 4:38:00 PM Automatic &

Group 4/19/2017 11:08:00 AM 11:08:00 AM Automatic t

Group 4/18/2017 11:01:00 AM 11:01:00 AM Automatic t
Save + Close Bt | [ nelp |

7. Click Save + Close.

Morningstar tRx February 2019 1
MOHNINGSTAH © 2019 Morningstar. All Rights Reserved.



Importing Data into tRx Overview

Importing Data into tRx

Now that you've scheduled automatic uploads from Morningstar Office into Overview
Morningstar tRx, your ready to import your extracted data into tRx in preparation
for rebalancing.

< Note: Data includes: households, securities, prices, and transactions. Open propasals will
need to be canceled or completed (sent to DISMISS or TRADES status).

Import your extracted data daily to ensure that the most up-to-date data is used during
the rebalancing process.

To import your automatically uploaded extract from Morningstar Office into tRx, do How do I import data
the following: into tRx?

1. From the Menu, select Workflow. Then click Import. The Import page opens.

MAORNINGSTAR Total Rebalance

Home b

¥ Warkflow |

Analysis
Trade Proposals g Click here to start
e | Clients

Recalculate

AUM $
» Client Management 91,150,761.93

el e A You have 10 of 12 clients that
require review.

» Trade Management

» Settings
» Help Requiring Review
Sign Out Out of Balance
Cash
Tax Loss Harvesting

View Analysis >

< Note: Click the pin icon to keep the Menu open.

2. Click the Upload Extract button. The Import Extract box opens.

Morningstar tRx February 2019 12
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Importing Data into tRx

How do | import data into tRx?

3. From the Import Extract box, click Import.

Import

Import Settings

Configuration

mport Method
Models Maintained In TRX
Model Typs

Rebalance Leve

Security Class Maintained In

TRX
dentify Cash Symbol

dentify Cash Security Class

PortfalioCenterimportService
Yes

Sector

Class/Sector

Yes

CASH

MMM

MCORNINGSTAR T

al Rebalance Expert

A newer data extract is ready for import

4. Upon successful import, the Active Data section reflects the new data.

MORNINGSTAR To

| Rebalanc

Cancel Proposals

Import
Extract

Created

Extract

Extract 5/7/2018, 4:51:44 PM Yes

Click this
Import button to
Extract Extract Created Imported "mpom data_
| ( Import | Extract 6/12/2017, 3:38:18 PM —
Data Settings
Active Data
mport Status Completed - 1/25/2019, 4:31:01 PM
Az Of Date 05/02/2018
Prices 05/03/2018
Transactions 04/01/2018 - 05/01/2018 T——
Realized Gains 04/01/2018 - 05/01/2018 status of your
data here.

0170172014 - 05/01/2018

MORNINGSTAR
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Householding in Morningstar tRx Overview

Householding in Morningstar tRx

Now that you've extracted your data, review each client record to ensure that the Overview
accounts comprised within each household are grouped in the in the strategy you want
to use to rebalance.

& Note: Accounts are imported using the same grouping as in Morningstar Office. If you want to
rebalance by individual account rather than by household, you must create individual
households in tRx which contain individual accounts.

In this section, the following topics are covered:

» Creating new Clients in tRx, (page 14) and
» Moving accounts into different Clients. (page 15)

To create clients in tRx, do the following: How do | create a new

1. From the Menu, select Client Management. Then select Clients. The Clients Client in tRx?

page opens.

MAORNINGSTAR Total Rebalance Expert

A

Home >
» Workflow
» Trade Management
¥ Client Management Clients Click here to start

Clients

Aesounts AUM $

. 51,150,761.93

gz You have 10 of 12 clients that
* |nvestment Modeling require review.
» Settings Requiring Review
» Help Out of Balance
Sign Out Cazh

Tax Loss Harvestin

Morningstar tRx February 2019 14
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Householding in Morningstar tRx How do | move an account to a different client in tRx?

2. From the Clients page, click Assign Clients. The Assign Clients page opens.

MORMNGSTAR Total Rebalance Expert

Clients

Click this button.

3. Inthe drop-down menu, select New Client.
4. From the grid, select the clients you want to combine.

5. Inthe text box next to the drop-down menu, type a name for the new client.

Assign Clients
I Clent v Allen, Ima I Growth L .
) _ | After selecting
L o Bl 012 ; "™ accounts, type a
name for your
R client here.
2 i o \ Clent " { Nmbar p -
| - - 8187 Allen, Philip and lrms Income Mign, lrms |RA IRA
| & i Philip an Income Mlen, Irma Fath ROTH
6. Click Update. Remain on the Assign Clients page.
To mave accounts from one client to another, do the following: How do | move an

account to a

1. From the Assign Clients grid, select the account you wish to move. . . .
g : / different client in tRx?

2. From the drop-down menu, select Change Client. The Select Client drop-down
menu appears.

Assign Clients >

Select the account
you want to move,
select Change
R— Client here.

widusl Acceunt  Taxsble T I

Morningstar tRx February 2019 15
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Householding in Morningstar tRx

How do | move an account to a different client in tRx?

3. Select the Client you want to move the account to.

Assign Clients

Change Client v

5 - Castle, Frank

Keaw Chant 1D

Select Chent

"1 8 - Banner Fanmly

3 - Barnes, Bucky

4 - Guardians of the Galaxy

11 - Parker, Peter

B - Rhodes, Jim

2 - Rogers, Steve

10 - Homanott, Natasha
12 - Stark, Tony

9 - Strange, Stephen Vincent

1 - Wakanda Family

flient

Corrant Chent.

Banner Family

Barnes, Bucky

Guardians of the Galaxy
Parker, Peter

Rha

flogers, Steve
Romanaéf, Natasha
Stark. Tomy

Stra

Madel

Hefty

Aggresive Gro..

Aeogunt Number Accwunt Descipbon

44952882

Bucky Bames IRA

Bruce Banner Indwidual Account

Frank Castie IRA
13307206 Petar Quill IRA
SO551655 Peter Pasker Roth IRA
E3RB0S10 Jim R L ual Account
58050906 Steve Rogers IAA
12194035 Nstasha Remaneff Indhidual
EDDIE14S
57092174

Account Type Cat
Taxable Tax
IR&
I7a

Traditicnal 1A

Tansdle
Tanshle
SEF IRA

4. Click Update.

Select the client
you want to
move the
account to here.

MAORNINGSTAR
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Creating Asset Class Categories

Overview

Creating Asset Class Categories

Now that households are created or changed, the next step is to create asset classes
for security categorization. Because tRx rebalances by asset allocation, all securities
must be assigned to a class and a subclass.

In this section, the following topics are covered:

» Creating Asset Categories at the class level, and (page 17)
» Creating Asset Categories at the subclass level. (page 18)

To create Asset Categories at the class level, do the following:

From the Menu, select Settings. Then select Classifications. The Classifications
page opens.

Overview

How do | create Asset
Categories at the class
level in tRx?

MOORNINGSTAR Total Rebalant

Click here to start.

»*
Home »
» Workflow
» Trade Management
» Client Management Clients
» [nvestment Modeling
¥ Settings | AUM §
Elohalsetings 51,150,761.93
Enterprise .
You have 10 of 12 clients that
Location Optimization ) .
e — require review.
Morningstar Registration Requiring Review
Data Maintenance Out of Bal
Dut of Balance
* Help Cash
Sign Out Tax Loss Harvesting

From the View drop-down menu, select Class.

3. Click Add Classifications. The Manage Classification box opens.

McORMINGSTAR Total R

Classifications

Select this
option.

MORNINGSTAR
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Creating Asset Class Categories How do | create Asset Classifications at the subclass level?

4. In the Text fields, Type Class, Description and Display Order into the text boxes.

Manage Classification X
Class * USEQ
Description - US Equity Type Cfl_ass data in
Display Order* ; these fields.

< Note: Display Orders can remain 0 until all classifications are completed.

5. Click Add. Remain on the Classifications page.

To create Asset Classifications at the subclass level, do the following: How do I create Asset
Classifications at the

1. From the View drop-down menu, select SubClass.
subclass level?

2. Click Add Classifications. The Manage Classification box opens.

MORRINGSTAR T

Classifications

Select this
option.

3. Inthe Text fields, type Subclass, Description and Display Order into the Text Boxes.

4. From the Class drop-down menu, select the Class you want your new Subclass to fall

under.
Manage Classification 4
SubClass oV
Description * Large Cap Value Type subclass data
Display Order * 0 in these fields.
Fast” usea v
@ Select the class from
this drop-down menu

< Note: Display Orders can remain 0 until all classifications are completed.

5. Click Add.

Morningstar tRx February 2019 18
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Creating Asset Class Categories

How do | create Asset Classifications at the subclass level?

The following table includes examples of class/subclass designations.

Class Description | Class Code SubClass Description SubClass Code
US Equity USEQ » LC Value » LCV

» LC Growth » LCG

» MC Value » MCV

» MC Growth » MCG

» SC Value » SCV

» SC Growth » SCG
Intl Equity INLEQ » Intl LC » INTLLC

» Intl SC » INTLLSC

» Emerg Mkts » EMG
Real Estate REET » USR/E » USRE

» Intl R/E » INTLRE
Natural Resources | NATRES » Commodities » COMM

» Natural Resources » NATRES
Strategic STRT » Strategic » STRT
US Fixed Income USFI » ST Bond » STBD

» Interm Bond » INTBD

» High Yield » HY

» TIPs » TIPS

» Govt Bond » GOVTBD

» CDs » CDS

» Indiv Bond » INBD

» Intl Bond » INTLBD
Intl Fixed Income INTLFI EM Bond EMBD

MAORNINGSTAR
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Assigning Securities in Asset Classes Overview

Assigning Securities in Asset Classes

After creating asset categories, the next step is to assign securities to your asset Overview
categories. With this, you will assign securities to Subclasses, and tRx will link the

correct class with the subclass you've chosen. Securities can be assigned one by one

through the Security Maintenance page, or in bulk using the Data Maintenance page.

In this section, the following topics are covered:

» Assigning securities to subclasses for individual securities(page 20)
» Assigning securities to subclasses in bulk using Microsoft Excel (page 22), and
» Uploading subclass assignment spreadsheets back into tRx.(page 23)

To assign securities to subclasses individually, do the following: How do I assign
1. From the Menu, select Client Management. Then select Securities. The Securities securities to subclasses
page opens. individually?

MORMINGSTAR Total Rebalance Expert

»*
Home >
» Workflow
» Trade Management
¥ Client Management CIientS
Clients
fecourts AUM $
Positions Click here to start.
— 51,150,761.93
Reports You have 10 of 12 clients that
* |nvestment Modeling require review.
» Settings Requiring Review
» Help Out of Balance
Sign Out Cash
Tax Loss Harvestin

Morningstar tRx February 2019 20

MOHMNBSTAH © 2019 Morningstar. All Rights Reserved.



Assigning Securities in Asset Classes How do | assign securities to subclasses individually?

2. From the Securities page, click on the Security you want to assign to a Subclass. The
Securities Setting page opens.

MORNINGSTAR Total Rebalance

Securities

100 v Page: 1 WV

Symbal Deseription Counts As Sacurity Type  TotalMitValue Sall Flag Bay Flag Demin Sell  Demsin Buy <. Click on a SECUI"\I\/.

L
MOORNINGSTAR Tort
Summary - AAPL | APPLE COMPUTER INC Security Sattings elat 1 d t Not m
Price Date Price Redemption Fee Penalty Interval
a1nang $153.10 & Newer Abwy
Redemption Fee Pemalty %: Redemption Fes Penalty Days: *

cusip Security Type

Selecta
SubClass from

I—'-ﬂ“‘“-“—l' Mame !
ULy v US Large Cap Valuz Buy Flag this menu.
& Suand dacd Profarepd if beld

Sall Flag

# Ok 1o sel

4. Click Save.

5. Repeat steps 2 through 4 for each security you want to assign a Subclass to.

Morningstar tRx February 2019 21
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Assigning Securities in Asset Classes How do | assign securities to subclasses in bulk?

To assign securities tosubclasses in bulk, you must first download an Excel
spreadsheet. Once downloaded, assign your subclass classification within the
spreadsheet. Once assigned, you must upload the spreadsheet back into tRx. To
download the Excel spreadsheet, do the following:

1. From the Menu, select Settings. Then select Data Maintenance. The Data Maintenance
SCreen opens.

+
bome |
» Wark
» Trade Management
» Client Management .
5 Clients
» Investment Modeling
¥ Settngs AUM $
Global Setti
o 51,150,761.93
Enterprise
Location Optimization You have 8 of 12 clients that
Classifications require review.
el BRI Reguiring Review Click here to start.
Data Maintznance
T SaETE
» Help N
Cash
Sign Out Tax Loss Harvesting

2. From the Data Maintenance drop-down menu, select Security Classification.

MOORNINGSTAR Total Rebalance Exper

Data Maintenance

Select File Type v
: e =
| Select File Type
Asset Class
Asset Subclass lto export to Excel for editing. Once finished, make sure the same type of data

Security Classification |

d upload the edited file. Thy

How do | assign
securities to subclasses

Select this option.

ecurity Settings
Allocation Model
Household
Account
Preferred Buys
Location Optimization
Restricted Plans

Morningstar tRx February 2019
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Assigning Securities in Asset Classes How do | upload my subclass assignment spreadsheeet into tRx?

3. Select Download File. The Security Classification Excel file appears at the bottom of
the screen.

MORNINGSTAR Total Rebalance Expert

Data Maintenance
Click this button.

Security Classification Vv

Select the type of data you wish to export to Excel for editing. Once finished, make sure the same type of data is selected and upload the edited file. TH

axported for that type

Field Format Values

Symbol — —
Description — —
Security Type — —

Subclass — —

From here, enter the Security Classifications you want to use within tRx into the
downloaded Microsoft Excel spreadsheet. Once complete, save your spreadsheet to
your local drive.

Now that you've assigned subclasses within your Excel spreadsheet, you must upload How do | upload my

your subclass assignment spreadsheet back into tRx. subclass assignment
. spreadsheeet into tRx?
To upload your spreadsheet, do the following:

1. From the Menu, select Settings. Then select Data Maintenance. The Data Maintenance
SCreen apens.

MAORNINGSTAR Tote

&~
Home  |>
» Waork
» Trade Management
» Client Management .
- Clients
» Investment Modeling
¥ Senngs AUM 3
Global Setti
ol 51,150,761.93
Enterprise
Location Optimization You have 8 of 12 clients that
Classifications require review.
Momingstar Registration Requiring Review Click here to start.
Data Maintznancs
UUL Ul baldlile
» Help -
Cash
gL Tax Loss Harvesting

Morningstar tRx February 2019 23
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Assigning Securities in Asset Classes How do | upload my subclass assignment spreadsheeet into tRx?

2. From the Data Maintenance drop-down menu, select Security Classification.

MOORNINGSTAR Total Rebalance Expert

Data Maintenance

Select File Type v
| Select File Type
Asset Class
Asset Subclass Ito export to Excel for editing. Once finished, make sure the same type of data is

Security Classification |

nd upload the edited file. Th

Select this option.

Security Settings
Allocation Madel
Household

Account

Preferred Buys
Location Optimization
Restricted Plans

3. Select Upload.

MORNINGSTAR Tot

Data Maintenance

4. Once the file is uploaded, select Import.

Click here to
import subclasses,

Morningstar tRx February 2019
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Creating Models

Overview

Creating Models

Now that Asset Categories (classes and subclasses) are created, and assigned
Subclasses are assigned to securities, the next step is to create models.

There are two types of Models available in tRx:

» (Classification which can include all subclasses excluding blends, and
» (Classification-Blend, which can include all subclasses including blends.

In this section, the following topics are covered:

» Creating a model, and (page 25)
» Assigning a model to household. (page 27).

To create a model in tRx, do the following:

1. From the Menu, select Investment Modeling. Then select My Models. The My Models
page opens.

MORNINGSTAR Total Rebalance

A+
Home »
* Wik
w Trade Management
» Client Management C|
- lents
v |nvestment Modeling |
Madel Marketplace AUM § Click here to start.
e
Ay Models | CAdarn 3na on
S T, TI0, 7030
Resticted Plans You have 8 of 12 clients that
Models of Models [Equire review.
Sub Blends
Requiring Review
» Settings
Out of Balance
» Help
Cazn
Sign Out Tax Loss Harvesting

2. From the My Models screen, click Add Model. The Add Model box opens.

MOORNINGSTAR Total Rebalance Expert

or models subscribed to from the Model Marketplace for your clients.

Overview

How do | create a model?

Select this button.

Morningstar tRx February 2019
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Creating Models How do | create a model?

From the Model Type drop-down menu, select Classification.

3

4. In the Model Name text box, type a name for the model.

5. Inthe Description Name text box, type a description for the model.
6

To create a new model based on an existing model, from the Copy From drop-down
menu, select a model.

Add Model X

Model Type: = ol

Model Name: *

Description =

Copy From Complete these fields.

(Optional): Select Model v

7. 5.Click Add. The new model is added to the My Models grid

8. From the My Models grid, select the model you just added. The Model Maintenance
SCreen opens.

MORNINGSTAR Total Rebalance Expert

My Models

Select from the below list of created models and/or models subscri

to from the Model Marketplace for your clients.

wnload CSV Display: 100 v Page: 1 v ofl
<All=
] Model Description Model Source In-Use-Status
[ Growth Growth Classification In-Use
[ Growth and Income Growth and Income Classification In-Use
Select the new model here.
(] Income Income Classification [n-Use

9. To assign allocations to your new model, click Add to Model. The Add to Model box
opens.

MORKNGSTHA Tota

Model Maintenance

Click this button.

m v Pagr 1w ol
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Creating Models

How do | assign a household to a model?

10. From the Add to Model box, select your Subclass from the SubClass menu.

11. Type Target% and Tolerance% into the text boxes.

Add to Model

SubClass: Sl

SubClass

Target % : 0

Tolerance % : 20

U

Complete these fields

12. Click Save.

13. Repeat steps 9 through 12 for each Subclass until the Model is fully allocated to 100%.

14. From the Model Maintenance page, click Save.

To assign a model to a household, do the following:

1. From the Menu, select Investment Modeling. Then select My Models. The My Models

page opens.

MORNINGSTAR Total Re

How do | assign a
household to a model?

» Trace Management

Click here to start

Models of Models

Sub Blends

» SeTings

» Help
Sign Out

» Client Management .
- Clients
¥ nvestment Madeling |
Model Marketplace AUM §
My Models | £ 100 309 09
S0y 5o T, 0T O
Restricted Plans You have 8 of 12 clients that

require review.

Out of Balance
Cash

mos Harpasting
1arvesting

2. From the My Models screen, click Assign Models. The Assign Models box opens.

MOORNINGSTAR Total Rebalance Expert

yw list of created

a Model Marketolaca
ym the Model Marketplace

for your clients.

Select this button.

MORNINGSTAR
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Creating Models How do [ assign a household to a model?

3. From the Assign Models grid, select the client or clients you want to assign the
model to.

4. From the Assign Model drop-down menu, select the model you want to assign.

Assign Models

Filter Assign Model List Assign Model: |  Aggresive Growth v (

| Choose a model here for
ey 10 W Poge: 1 v 2> % TERRIMETEEE - the clients you've selected

=/4'pﬁnn Currant Modal Mow Madal Model Typa Advizor Sat Value
L
®  Banner Family Aggresive Growth — Classification Blain Hefty $1.802.393
B Bames Buck Al Growth = Classification Blain Heft: £251.869

(] Castie, Frank Funds Grawth - Classification Blain Hefty §2,669,245

Guardians of the Galaxy Hefty th Model (ETF/MF) - " ation Blain Hefty 534670414
Parker. Peter Func — Blain Hefty $2,251.363
[]  Rhodes, Jim Hefty Growth Madel (ETF/MF) — Blain Hefty 7
Rogers, Steve Hefty Grow (ETF/MF} - Test
(] Romanoff, Natasha Blain LLG Total Beta 40/60 - Blain Hefty
(] Stark Tany Ah. Growth - Test
Strange, Stephen Vincent Opp C model - Classification Blain Hefty

5. Click Update.

Morningstar tRx February 2019 28
MOHNINGSTAH © 2019 Morningstar. All Rights Reserved.



Creating Buy Sets

Overview

Creating Buy Sets

After creating models select your preferred funds for each subclass represented in your
models. The Buy Sets screen only populates with subclasses from models.This set of
preferred funds is your Buy Set and signals tRx which trades to propose when subclass

allocations are under weighted.

To create a buy set, do the following:

1. From the Menu, select Investment Modeling. Then select Buy Sets. My Models

page opens.

MORNINGSTAR Total Re

» Trace Management

Models of Models
Sub Blends
» SETNgs

» Help

Sign Out

» Client Management -
i Clients
¥ nvestment Madeling
:Od\el [Ir-u'TkEmaCE AUM $ Click here to start.
frr-UUEb LA 10 7001 09
ZU'.-'SE'TE T T, T T
R You have 8 of 12 clients that

require review.

Out of Balance
Cash

3 Los3 Harvesting

2. From the Buy Sets page, click on a SubClass you want to apply your preferred securities
to. The Buy Fund by Class and Custodian box opens.

Overview

How do | create a buy set

Buy Sets

Buy Set: Selact Preferred Buy Set Vv Type:

Click on the row of
the subclass you
want to assign.

MORNINGSTAR
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Creating Buy Sets How do | base a buy set on an existing buy set?

3. There are four security types for each subclass:

> IRA
» ROTH
» TAX
» TLHA

Select each security type to assign a preferred security. Then use the drop-down menu
to select a preferred security.

Buy Funds by Class and Custodian

Buy Set:  Standard SubClass / Symbok:  INTLGTH - Internations] Growth

v Select preferred
" ity securities here.
DFABV | DFA Abs Broad Veh

Custodian: DEFAULT W Security:

< Note: The fund selected for TLHA i.e. Tax Loss Harvesting Alternative cannot be the same as
the fund selected as your favorite for the TAX category. This is because the TLHA fund
becomes your replacement favorite fund when your preferred TAX fund has losses being
harvested during Tax Loss Harvesting.

In some cases, you may need to create additional buy sets to fulfill specific needs of a How do I base a buy set
client. This can be accomplished by basing a new Buy Set off an existing Buy Set. on an existing buy set?

To create additional Buy Sets, do the following:
1. 1.From the Buy Sets screen, click Manage Sets. The Manage Buy Sets box opens.

MORNINGSTAR Total Rebalance
Buy Sets
| Managa Set | Buy Set:  Salect Prefarred Buy Set v
" Rufresh L Download C! 00w Page: 1 v ofl
Select
preferred
SubClass / Symol ™ RaTH " TIHA securities here.

2. From the drop-down menu, select the Buy Set you wish to copy, then click Copy.

3. Inthe Enter a Name text field, type a unique name for the Buy Set.

Morningstar tRx February 2019 30
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Creating Buy Sets How do | base a buy set on an existing buy set?

4. In the Enter a Description, type a descriptioinfor your new Buy Set into the text boxes.

Manage Sets

) Enter details here

5. .Click Save.

6. From How do | create a buy set on page 29 and follow steps 3 though 5 to update your
preferred investment selections for your new buy set.

Morningstar tRx February 2019 31
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Troubleshooting Data Errors after Import

Overview

Troubleshooting Data Errors after Import

After importing data from Morningstar Office into Morningstar tRx, you may encounter Overview
an error that must be corrected. This section explains how to fix common warnings you

may encounter.

Within Morningstar tRx, there are two types of errors you may encounter: What errors might |

» Critical errors, which will prevent a household from rebalancing, and

encounter in tRx?

» Non-critical errors, which won't prevent rebalancing but could affect the accuracy
of trades proposed or efficiency in your use of tRx.

Review errors after your daily import and resolve them using the table below:

Error number

Cat 1

Error Description

Funds without a Class/Subclass

Tips for resolving the error

tRx requires all held securities have a correct
Class/Subclass designation to accurately rebalance
portfolios. If securities are maintained in your Portfolio
Accounting System (PAS), fix by giving the security
missing a Class/Subclass an appropriate
Class/Subclass assignment. If maintained in tRx, fix
by updating from the Security Maintenance screen.

Cat 2

Accounts not Categorized as IRA/
ROTH/TAX

For tRx to efficiently identify what types of securities
should be held in what account types, each account
must have a category IRA/ROTH/TAX. Assign the
correct account type in your PAS or go into the
Account Maintenance screen in tRx and give the
account the appropriate type.

Cat3

Accounts without a Custodian (correctable)

Accounts must have a Custodian assignment in order
to create Custodian specific trade files. Make sure the
account is assigned a Custodian in your PAS. Held
away accounts or other similar accounts that do not
use trade files still require a "dummy" custodian as
this critical error will prevent a rebalance.

Cat 4

Accounts without a Household

tRx rebalances portfolios at the household level; every
account must therefore belong to a household. Go
into your PAS and assign the account(s) a household.

Cath

Household without a Model

A Model must be assigned to each household in order
to rebalance to your Model Subclass/Class
allocations. If Models are maintained in your Portfolio
Accounting System (PAS), fix by assigning the
household a Model from your PAS. If maintained in
tRx, fix by updating from the Models Maintenance
screen.

MAORNINGSTAR
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Troubleshooting Data Errors after Import What errors might | encounter in tRx?

Error number | Error Description Tips for resolving the error

Cat6 Household not in an Advisor Set Advisor Sets can be used as a filter for
multi-household functions in Analysis Expert involving
TLH, Cash Needs or Rebalance. Fix in tRx from the
Household Details screen by updating the
household's Advisor Set under Group Settings.

Cat7 Fund Subclass not in Model The security in question has a Subclass that is not
represented in the Model assigned to the household.
tRx will attempt to liquidate unless marked as Do Not
Sell or excluded from positions. Review fund Subclass
or Model assignment and update as necessary.

Cat9 Subclass without a Class Each Subclass must be assigned a Class. Fix in your
PAS by reviewing and updating missing Class.

Cat 10 Subclass not represented in Preferred Buys Subclasses in Preferred Buy Sets are populated from
the Subclass allocations in Models. If you do not see a
Subclass listed, check that you are viewing the
appropriate Buy Set and check Model Subclass
allocations are correct from Models Maintenance
screen.

Cat 11 Subclass without a Preferred Buy Fund For tRx to propose trades of your preferred securities
per Subclass, each account type must have a
preferred buy fund. In the navigation menu select Buy
Sets. Assign a preferred buy security to TAX, ROTH
and IRA account types (TLHA - Tax Loss Harvesting
Alternative is optional).

Cat 12 Household with no accounts tRx rebalances portfolios at the household level. Each
household must therefore contain at least one
account. Assign an account(s) to the household(s) in
error or remove from the PAS extract.

Cat 13 Funds with current price of $0 All managed positions must have a current value in
order to be traded. A trade file will not be generated
unless missing price is updated. To fix, update price
using override price in tRx and regenerate proposal or
update price in PAS and run a new import to tRx. The
position(s) could also be marked as unmanaged if
necessary.

Cat 16 Subclass without a TLHA Preferred Buy Fund Tax Loss Harvesting opportunities for a security in a
Subclass without TLHA fund cannot be realized. Each
Subclass requires a TLHA Preferred Buy Fund to
generate TLH transactions. To fix, go to the
appropriate Buy Set, select Subclass in error and
update with fund alternative.
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Troubleshooting Data Errors after Import

What errors might | encounter in tRx?

Error number

Cat 17

Error Description

Set sell method to “High cost” or “Beneficial
tax.”

Tips for resolving the error

The account in question likely has a matching method
that is not set to "High cost" or "Beneficial Tax" in the
PAS. This means tRx is not getting accurate lot
information. Trades proposed by tRx assume specific
lots are being sold. The assumptions tRx makes are
most in line with "High cost" or "Beneficial Tax". The
custodian ultimately determines which lots get sold.

Cat 18

Account without a Tax ID

tRx requires Tax IDs to correctly recognize wash sale
violations. These do not have to be actual Tax IDs but
could also be unique identifiers for accounts. To fix,
update account with missing ID in your PAS.

Cat 19

Account Category of Tax not flagged Taxable

For tRx to efficiently identify what types of securities
should be held in TAX vs TAX DEFERRED, each
account must have an accurate taxable flag. Assign
the correct taxable status in your PAS or if applicable
go into the Account Maintenance screen in tRx and
give the account the appropriate flag.

Cat 20

Taxable account not categorized TAX

For tRx to efficiently identify what types of securities
should be held in TAX vs TAX DEFERRED, each
account must have an accurate taxable flag. Assign
the correct taxable status in your PAS or if applicable
go into the Account Maintenance screen in tRx and
give the account the appropriate flag.

Cat 21

Funds with inconsistent Class/
Sector/SubSector

Each Subsector must be assigned to a unique Sector;
each Sector must be assigned to a unique Class. In
your PAS make sure to assign the fund(s) a consistent
class/Subclass structure. For example, if one fund has
a Subclass of SVC with a class of SC, another fund
cannot have SVC as its Subclass and MC as its class.
Keep it consistent.

Cat 22

Model with Allocations that do not total 100%

Target allocations for the Subclasses in the Model do
not add up to 100%. To fix, review your Model to
ensure allocations total 100%. Update in your PAS or
tRx as applicable.

Cat 23

Account Positions are Doubled in Rebalance
Set (correctable)

This situation occurs when an account(s) is in more
than one household. Fix in your PAS by reviewing and
updating households to have unique accounts. Do a
full extract and import into tRx after updating
households in your PAS.

Cat 24

Blank or Duplicated account numbers have
been omitted from Import

Blank or Duplicated account numbers have been
omitted from Import. Fix in your PAS by reviewing and
updating account numbers. Do a full extract and
import into tRx after updating account numbers in
your PAS.

MAORNINGSTAR
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Troubleshooting Data Errors after Import

What errors might | encounter in tRx?

Error number

Cat 25

Error Description

Classes without a Sort Order

Tips for resolving the error

Asset Classes are missing a display order. Fix in tRx
from Global Settings > Classifications. Select Class
and update display order as necessary.

Cat 26

Subclasses without a sort order

Asset Subclasses are missing a display order. Fix in
tRx from Global Settings > Classifications. Select
Subclass and update display order as necessary.

Cat 27

Household with Invalid Model Type

Models used in tRx must have a singular consistent
Model Type. Models are either all of subsector type or
of the sector type. To fix, update Model in question
from your PAS to have same type as other Models.

Cat 28

Account Set Aside Cash exceeds account
value

Set Aside Cash must fall below the account value to
accommodate cash withdrawals based on Set Aside
Cash settings. To fix, update Set Aside Cash for the
account from the Account Maintenance screen in tRx.

Cat 29

Model not in use by any Household (delete
from tRx)

If a Model is not in use/assigned to any households it
can deleted from the Investment Models screen in
tRx.

Cat 30

Account Cash below minimum Set Aside Cash

Set Aside Cash Minimum ensures that a minimum
amount of cash is retained in the account upon
Rebalance/Cash needs function. With an account's
cash below Set Aside, tRx cannot reach the Set Aside
Minimum. To fix, adjust accordingly the Set Aside
minimum downward for the account from the
Account Maintenance screen in tRx.

Cat 31

Restricted Plan Security has invalid Subclass

A Restricted Plan consists of securities to be traded in
the associated Restricted Account. Changes to the
Subclass of a security in a Restricted Plan after a
Restricted Plan is created will cause this error. To fix,
delete the security in error from the restricted plan in
tRx and/or replace with another of consistent
Subclass or change the Subclass for that security
accordingly.

Cat 32

Restricted Plan-Invalid Security

The security in error is no longer part of the Restricted
Plan. It is possible that it is no longer held by any
accounts and was not brought down in the last
import. To fix, delete the security in error from the
restricted plan in tRx and/or replace with another
security as needed.

Cat 33

Restricted Plan not in use by any Account
(delete from tRx)

The Restricted Plan in error is no longer assigned or
has yet to be assigned to an account. To fix, delete
Restricted Plan if no longer in use or assign to a
Restricted Account in tRx.

MAORNINGSTAR
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Troubleshooting Data Errors after Import

What errors might | encounter in tRx?

Error number

Cat 34

Error Description

CUSIP needed for securities traded as Mutual
Funds

Tips for resolving the error

The security in question is missing a CUSIP. To fix, edit
the security details in your PAS to include CUSIP and
reimport to tRx or if applicable, delete and recreate in
tRx with CUSIP from the Security Maintenance
screen.

Cat 35

Funds with an Invalid Security Type

Security Types are assigned in your PAS and import
into tRx accordingly. To fix, edit the security type in
your PAS. Review Security Types from the Securities
screen or Global Settings > Security Types.

Cat 36

Preferred Buy Funds where Alternate also has
a Deminimus Buy Restriction

tRx cannot propose a trade for either the Preferred
Buy security or the assigned alternate security
because the minimum trade amount was not met. To
fix, lower the minimum trade amount for the Preferred
Buy security and/or alternate or pick another security
with no or appropriate deminimus as the alternate.

Cat 37

Subclass tolerance range greater than Class
tolerance range

This indicates that the Subclass in question is in

balance while the associated Class is 00B. To fix,
adjust the tolerance ranges accordingly from the
Model Detail screen in tRx.

Cat 38

Sum of positions are not equal to account total
value

This is due to importing data from your PAS that is not
fully reconciled. For the account in question, the
overall value of held positions has a value different
from the account's value. To fix, review and reconcile
positions in PAS as needed and reimport into tRx.

Cat 39

Sum of Cash Positions do not equal PAS Cash
Account total

This is due to importing data from your PAS that is not
fully reconciled. For the account in question, the
overall value of Cash and Cash Equivalents has a
value different from the account's stated Cash. To fix,
review and reconcile cash positions in PAS as needed
and reimport into tRx.

Cat 40

Account Numbers are duplicated in PAS
extract .

There are multiple instances of the same account
number importing into tRx from your PAS. To fix, verify
and update your Rebalance Set used for import into
tRx to have unique accounts for export.

Cat 41

Account Portfolio value does not equal sum of
PAS Trade Lots

This is due to importing data from your PAS that is not
fully reconciled. For the account in question, the
combined value of all trade lots has a value different
from the account's stated value. To fix, review and
reconcile trade lots in PAS as needed and reimport
into tRx.

Cat 42

Account portfolio has positions without a
symbol/ticker/CUSIP

tRx requires all securities have a ticker symbol or
CUSIP to propose trades. To fix, review and update
position in question with correct symbol or CUSIP in
PAS and reimport into tRx.

MAORNINGSTAR
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